TRN

Praparad, Ontrack. Onling.

A Learning Management System for Professionals Who Protect the Public’s Health

USER GUIDE

How to login to the TRAIN Network

1.

2.

3.

Type “http://mi.train.org” into the address field of your browser.

When prompted for your User Name and Password, type;
User Name: Password: and click the Login button.

The resulting page will be the TRAIN Member Login screen.

NOTE: If you are a first time user, you will need to register by following the instructions below. If
you have previously registered as a member, enter your Member Login Name and Password then
click the “Login” button.

How to Create Your Own Learner Record

Go to the TRAIN site. Member Login
Click on “Create Account” which appears underneath the login on Login Narme:

the left hand side of the screen. |
Fill out all the necessary information on the subsequent pages. Passward:

Required fields are indicated with a red asterisk (*). Do not hit your J
browser’s “Back” button at any time during the registration

process. Instead, use the “Back” and “Next” buttons at the b Login to your TRAIM
bottom of the pages. account:
Login ]

Answer the two secret questions at the bottom of the page with easy-
to-remember, one-word answers. In the event that you forget your
password, these questions will be posed as a security measure
during the password retrieval process. Click “Next” when finished.

* Setup a new TRAIN

G

Create Account ‘

On the resulting page, you will be asked to choose the preparedness
region in which you work, as well as the county in which you work.
You will also be asked to provide your job role(s) and work setting(s).

Please select up to 3 professional roles that best match your job
description. Some roles may require you to select a specialization
from the adjacent drop down menu. If you select “Other,” please type
your specialization in the space provided. Click “Next” when finished.

On the resulting page, please select up to 3 settings that best fit your
work environment. Click “Next” when finished.

On the resulting page, additional demographic information will be
requested. This information is not required for registration. Click
“Continue” to finish registering for TRAIN. You are now free to enter
the site.

Note: Learner profile information can be edited at any time following
registration by clicking on My Account.


http://mi.train.org/�

How to Edit Your Learner Record

Log on to the TRAIN site.

From the home page, click “My Account” from the “My
Learning Record” box located on the right hand side of the
page.

On the resulting page, change text and settings as needed

(including your password, if desired) by clicking on either the
“Details,” “Groups,” or “My Profile” tab.

| My Learning Record

B Wy Learming

¥ Transcript

F Cadificates

¥ Course Archive
* My Account

How to Search for Courses

1.

4.

Click on the “Course Search” tab, located in Navigation Tab
bar at the top of the screen.

On the resulting page, select the appropriate criteria for your
search from the menu that appears on the left hand side of
the page.

Next, either select your search variables from the list or enter
your search query in the field provided. You may select
multiple variables by holding down the Control key while
making your selection. Search Options List Menu

Click “Search” to search for your desired courses.

Note: “Advanced Search” allow you to combine several criteria in
one search.

Search Options

>
>
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Browse All
Browese My State Qrnly

By Suhbject

By Target Audience
By Competency

By Format

By Credit Type

By Date

By Distance
Keyord Search

Advanced Search



How to Save Search Criteria (Let TRAIN search for you!)

For your convenience, you can also save sets of search criteria for future searches by clicking the
Save Criteria button. Additionally, you can request email notification when a course is added to
TRAIN that matches your saved search criteria.

Home Course Search Discussion Boards Resources Help Core Competencies About This Site
» Browse Al Tip: To sort by any calumn, clickthe column heading. Or use default order by Mumber Of Reviews
» Browsa My State Only Tip: Toview course description, click on the Course Title Search returned Deourses.
Tip: Alphabetical page indexing is used when sorted hy Title, Provider or Format.
» By Subject To save the criteria for this search please click here:

» By Target Audience

Ho courses have been found satisfying the search cri*éria.

» By Format
» By Credit Type To save the criteria for this search please click here;
» ByDate =
|@ ’_ |E|° Internet 4
Home Course Search Discussion Boards Resources Help Core Competencies About This Site
» Browse All Saved Search Criteria

P Browse Wy State Only

» By Subject
» By Target Audience

Please enter name for the new search criteria [ENter a Meaningful Name Hers

» By Competency Motify me about courses satisfing this search criter@ v

» By Format
- By Credit Type
=
Dione Intetnet
4

To be notified by email, check “Notify me about courses
satisfying this search criteria.” If you prefer not to receive email Search Options
from TRAIN, leave this box unchecked. You will then need to
access the saved search criteria sets by clicking on Course
Search, then Saved Search Criteria.

B Browse All
Browse My State Only

v

By Subject

By Target Audience
By Competency

By Format

By Credit Type

By Date

By Distance
Kewword Search
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How to Register for Courses

NOTE: It is important to remember that TRAIN is a Learning Management System and NOT a
Course Provider. Most registration and course questions will need to be directed to the course
provider contact listed in the Contacts tab of the course description.

1. Locate your desired course either using the method outlined in “How to Search for Courses”
or by clicking on “Browse” to browse through the list of course selections.

2. Select the course you wish to register by clicking on the title of the course.

Home Course Search Discussion Boards Resources Help Core Competencies About This Site
Search Options
Tip: To sort by any column, click the column heading. Oruse default order by Mumber
(> e il O?Reviews ¥ any ' g ¥ Search returned 646courses.
» Browse by State Only ) . - . y Too many? Try our Advanced
Tip: Toview course description, click an the Course Title Search
) Tip: Alphabetical page indexing is used when sorted by Title, Pravider or Format.
» By Subject
» By Target sudience To save the criteria for this search please click here: I

» By Format

) ) ) Mewy York-New Jersey Public Health Weh-hased Training - il
» By Credit Type Grientation to Public Health Training Center Self-study 8 reviews
» By Date i inici .
i D e e poue | CDCIPubic Health Training Network Webstreamifrchived  RoRrfelts
» By Distance pvp ' R {PHTH) Wehcast f reviews
» Keyword Search e TITETOrY SyrToTeRae [ 1]
Anitmal Bites and Rahies Morth Carolina Center for Public Health Computer-hased m
» Advanced Search Freparedness Training 5 reviews
Core Curriculurm on Tuberculosis | Centers for Disease Control & Prevention EB-IEREE TEIRE - .o i. LE
» Saved Search Criteria Self-study 5 reviews
Crisis and Emergency Risk MDCH Office of Public Health Web-based Training - Yrfriednt
Communication Online Warkshop | Preparedness Selfstudy A reviews
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3. The resulting pages display additional course details, course provider contact information,
registration information, and course reviews.

4. You may view reviews of the course by clicking the “Review” tab, or view the contact
information for your course by clicking the “Contacts” button at any time before, during, or
after the registration process.

5. To register for the course, click the “Registration” tab. Note: there are 3 different categories of
courses in TRAIN, each with its own registration process as described on the next page.



Live Event

(e.g., Conference, Workshop,
etc.)

If this is an onsite event with
multiple locations/sessions,
click the “Get Locations”
button to view all sessions.

Click the “Register” button
next to the session of your
choice. You may need to
follow the course provider's
additional registration
instructions.

TRAIN Course Categories

Physical Carrier

(e.g., CD-ROM, VHS, DVD,
etc.)

Some courses may consist of
training materials that need to
be ordered and/or purchased
from the course provider.

Click on the Register button to
add the course to your my
Learning section, then follow
the course provider’'s
additional registration and
ordering instructions.

Online

(e.g., Web-based self-study,
“on demand” or archived
webcast, etc.)

If the course is self-launching,
you will be able to immediately
access the course. Otherwise,
there may be payment or a
supplemental registration
procedure.

To launch the course, click the
“Launch” button (if available)
or follow the course provider’s
additional registration
instructions

NOTE: Some courses/events require registration steps outside of TRAIN. Please follow the
course provider’s instructions regarding their registration process. If you have questions about
external registration, please contact the course provider directly using the contact information
provided under the “Contacts” tab.

You will receive a registration verification email from TRAIN. You can also verify registration by
clicking on My Learning. The course should be listed as “In Progress.”

How to Launch a Course for Which You Have Already Registered

1. Log on to the TRAIN site.

2. From the home page, click “My Learning” from the “My
Learner Record” box located on the right hand side of

the page.

3. Onthe resulting page, you will see a listing of all the
courses for which you are registered. To launch a

course, click on its title.

| My Learning Record

* Wy Leaming

* Transcripl

F Cerificates

* Course Archive
* My Account

How to Mark a Course Completed, Archive, or Withdraw from a Course

Log on to the TRAIN site.

From the home page, click “My Learning” from the “My Learner Record” box located on
the right hand side of the page.

3. Onthe resulting page, you will see a listing of all the courses for which you are
registered. To change the status of a course, click on the “M” (manage) icon.

4. In the course management page, you can click on the “Completed” button to mark the
course completed, sending it to your Transcript. Note: You will be able to enter a score, if
applicable. To archive a course to resume later, click on the “Archive” button. To
withdraw from a class, click on the “Withdraw” button.




How to Add Non-TRAIN Courses to Your Course Record

1. Log on to the TRAIN site.

2. Onthe home page, click “Transcripts” from the “My Learner Record” box located on the right
hand side of the page.

3. Onthe resulting page, you will see all of the courses, which you have take listed in the
“Transcripts” table.

Click on the “Review” button to post review of the course.
To remove a course from your transcripts click the “R” button.

TR

Click on course title to view course details
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6. Toadd non-TRAIN courses and
courses you have already taken (in * ~ required fiells.

the past year) to your transcripts,

click on the “Add” button located to e
the right of the “Non-TRAIN Courses” SC‘:"““‘)::‘:
header. -
7. On the resulting page, fill out all the Course URL:
necessary information, and click the Course Format: | Go-Rom =

“Save” button.

Other Course
Format:

Cowrse Provider
Name:™

Score:

Credit Type:™ Mane Offered P
Amount:
Contact Name: ™
Contact Phone:
Contact Email:

Additional Info:



How to Post a Review

Log on to the TRAIN site.

2. Locate your desired course
using the steps outlined in
“How to Search for Courses

. Faking :
above. If you would like to
review a course that you are Comements

currently enrolled in or have
completed, you may do so
from the “My Learning” page
located in the “My Learning
Record” box on the right
side of the TRAIN Home

page.

Courge Dataile

Contatis

Ragizlration

Reviews

Huwe do wiod rale S everall quality of this course, cansidering ils comienl,
organiztion, instructional methids, and use oflechnalogy™

” 1=very Poos, 5=Viry Good

1 gtar 17 2 Sare 3 Stars (7 4 Stars € 5 Slars

Tithe ;|

Show mame ;[

Update | [ Cance |

3. Click on the title of the course you would like to review, to display the course details. On the
resulting page, click on the “Reviews” tab and then the “Add” button.

4. Fill out the rating, comments, and title fields of the form.

NOTE: If you want your review to be posted anonymously, simply uncheck the “Show name” box.

How to Use the Resources Section

Log on to the TRAIN site.

2. Click the “Resources” tab in the
Navigation Bar at the top of the
screen.

3. Onthe resulting page, you have
several options:

e To locate a resource, choose from
the categories listed in the menu
on the left hand side of the page
or use the “Keyword Search”
function.

e Toread a resource document,
click on the title of the document
you wish to view.

B Competency Resources
B Course Evaluation Tools
B General

B Needs Assessment

Hinaond Search

| A Categories |
" Dotument Name
” Deseriplion
& Both

Home Course Search Discussion Boards Risou
Categories:
ERT
B smallpox Document Namea

# CDe Report { pdi)

Biological and Chemical Terrarism:

Sirateqic Plan for Preparedness and Response
Recommandations of the COC Strateqgic

Flanning Warkgroup

SDCHE PRIMER ON BIOTERRORISM

The San Diego County Medical Society is please
understand the physician’s role in a biological or
allack Ve are the caregivers for the comrunity.
care, reassurance and counseling, you must haw
Crirty Bomnb  doc)

Lesarmn foore about the fallout of this deadh weap
Hormaland cocinte f Ao

4, To add a resource, click on the “Add Resource” button.

e On the resulting page, fill in the necessary information in the fields provided.

e Click the “HTML Mode” box to format the description with HTML.

e To upload a document, select the “Upload File” button, then type the path location of your
document or click “Browse” your computer.

e To create a link to a web site, select the “URL to Browse” button, and type in the address

of the web site in the text field.

e Click the “Save” button to submit the resource for approval by the state or national TRAIN

administrator.



How to Use the Discussion Boards

Log on to the TRAIN site. (e e

Click the “Discussion Boards”
tab in the Navigation Bar at the 1 Mo Conrse out of Denver

[+ & Streaming Video Helpll  Hemman Belkin - Mebraska 051372003 1610

Edweard Carvar Chig 051 H2003 1605

top of the screen.
On the resulting page, you have
several options:
Choose a topic from the menu
on the left hand side of the
screen.
Expand a discussion by clicking Streaming Video Helpit
on the ‘+’ next to the discussion
thread. Author:

Date: 51372003
Click on the title to view a .

v gola 2 houwr presentation that | need to ¢
message. benefils of Real Media ve. Windows Media v
Click the “Reply” button to reply . . .

Reply | | Back 1o Threads |

to a message. - . -

Click on the “New Thread”
button to create a new thread, fill
in the necessary information and
click on the “Submit” button.

What to Do if You Forget Your Password

1.

2.

Go to your TRAIN Login page.
Enter your login name in the appropriate field.

Below the “Create Account” button, at “Forgot Password?”
click the “CLICK HERE” link.

On the resulting page, you will be asked to respond to the
two secret questions, which you previously answered when
registering for TRAIN.

Your password will be displayed. It will not be e-mailed
to you.

Member Login
Login Mame:

|

Fasswiord:

¥ Login toyour TRAIM
account

Laogin j

F Setup a new TRAIN
account

Create Account ]

¥ Forgot Password? Entef
Login Mame above and

CLICK HERE




Where to Find Help

e Click the “Help” tab in the Navigation Bar at the top of the screen.
For additional help or information on MI-TRAIN, contact:

Deborah DeLong, MI-TRAIN Administrator
Michigan Department of Community Health
Office of Public Health Preparedness
201 Townsend Street
Lansing, MI 48913
Phone: 517-335-8150
Fax: 517-335-9434
Email: mi-train@michigan.gov

I R \;! N Powered by Traini ng@der
s

Prepared. Ontrack. Online,

Office of Public Health Preparedness

eoca
PHF

Public Health Foundation
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